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Jll Read me first

READ THIS MANUAL COMPLETELY BEFORE ASSEMBLING
AND POWERING UP YOUR PRINTER!

Hazards and Warnings
The Homers Tarantula RS 3D printer has motorized and heated parts. When
the printer is in operation always be aware of possible hazards.

Burn Hazard

Never touch the extruder nozzle, or the heater block without first turning o”
the hotend and allowing it to completely cool down. It usually takes the
hotend twenty minutes to completely cool down. Also, never touch recently
extruded filaments. The filament can stick to your skin and causes burn.

Fire Hazard

Never place flammable materials or liquids on or near the printer when
powered on or in operation. Liquid acetone and vapors are extremely
flammable.

Pinch Hazard
When the printer is in operation, be careful never to put your fingers in the
moving parts, including the belts, pulleys, gears, wheels or leadscrews.

Static Charge

Make sure to ground yourself before touching the printer, especially the
electronics. Electrostatic charges can damage electronic compo- nents. To
ground yourself, touch a grounded source.

Age Warning

For user under the age of 18, adult supervision is recommended. Beware of
choking hazards around children.
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]l TEVO Support specification ||}

Dear Customer, Tarantula PRO V1 Specification

235 x 235 x250 mm / 9.25 x 9.25 x9.84 inch

Thank you for purchasing TEVO 3D printer. Buildjvolume

With 3 years of rapid development, today we are privileged to con-
nect with thousands of customers every day with superior products
and more than 100 distributors in over 30 countries and regions. We
believe excellent product and service are the keys to win customers
support and expand the market.

We are proud to have you be a TEVO member, to have you in the
Big TEVO family, and we can "print” our dreams into reality. Togeth-
er we will make better work and a better life.

For any question please refer to: https://help.tevo.cn

TEVO social medias:

Facebook Group

(5124 331

Youtube Channel Twitter
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Layer resolution
Build speed

Travel speed

Heat bed type

Print surface
Filament diameter
Supported materials
Print technology
Feeder type

XYZ resolution
Nozzle type

Nozzle diameter
Nozzle temperature

Nozzle heat up time

Build plate heat up time

Operating sound
Input/Output
Power Supply
Control board
Product weight
Shipping weight
Product dimension

Shipping box

Support for slicing software

Assembly model

0.05mm-0.35mm
60mm/s-150mm/s

250mm/s

AC Platform Heat Bed

PC Platform

1.75mm

PLA, Flexible PLA, Wood, PVA
FDM(Fused Deposition Modeling)
Tevo Titan Bowden type

0.05mm, 0.05mm, 0.1mm
Volcano

0.4mm

180°C-240°C

< 3 minutes, 0-240°C

< 1 minutes, 0-180°C

< 30dBA

AC 110V-240V, 50-60Hz, DC 24V, 8.5A

220W, FCC, ROSH, CE Certification etc.

MKS SGen L V1.0, MKS TFT24 V1.0 TP, TMC2208

7.7kg Approximately

9.7kg Approximately

434 x 333 x 504 mm / 17.09x 13.11 x19.84 inch

500 x 440 x 190 mm

Simplify3D, Cura, Slic3r, Repetier host etc.

DIY KITS (Prebuilt Mainboard Wires, rest of kits DIY)
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Jll Packing list

LAYER A
A-01

53-01326A T8 Lead scew, 8mm, 4teeth, 8mm 1 —
52-01692A Aluminum extrusion, 2040, 400mm, Vslot, Y axis 1 _
52-01694A Aluminum extrusion, 2040, 350mm, Vslot, left/right 2

52-01693A Aluminum extrusion, 2040, 250mm, Vslot, mid 1 _
A-01 Screw bag

SKU Item Pcs Label
56-01687A M5x30 socket head bolt 4 v
56-01337A M5x45 socket head bolt 4 Tewo
56-00076A M5 whasher 8 Tarantula RS
56-01271A M4x20 socket head bolt 4

56-00003A M4 TNUT 4

59-01597A Rubber foot, 24*19*31mm, 5mm diameter 4

A-02

59-01723B Front panel, for screen 1

11-01200B MKS 2.4 inch touch screen 1

A-02 Screw bag

SKU

56-01893A
09-01080B
56-00292A
56-00620A
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Item

M3x10 bolt

LCD wire, 8pin, 0.6m
M5x8 socket head bolt
M5 T nut

Pcs

A D R BN

Label

ero

Tarantula RS

Screws
A-02

A-03

07-00032A Stepper Motor » 40mm

56-01696B Metal panel - forY axis

A-03 Screw bag

SKU Item

56-01697A Y frame

53-00169A Flange bearing F624zz
56-01335A M4x25 socket head bolt
53-01338A Spacer 4.2mm*7mm 6mm high
56-00624A M4 Locknut

56-00460A M4x8 socket head bolt
56-00003A M4 T nut

56-00854A M3x6 button head bolt
53-00008A Timing wheel 5mm

A-04

control box (pre-assembled)

A-04 Screw bag
SKU Item

56-00292A M5x8 flat head bolt, M/C

56-00620A  M5TNUT

Packing list ||

N L=

Pcs Label

1

2

2 evo

1 Tarantula RS
2

5

5

4

1

Pcs Label

4

Tarantula RS

Screws
5 A-04
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Jll Packing list

LAYER B

I? @ Screw B-08

B-05 -06

53-01326A  Aluminum extrusion » 2020 + 330mm - V slot 1 o ——

X . — |
52-01316A Aluminum extrusion » 2020 > 345mm - V slot 1 _
52-01691A  Aluminum extrusion » 2040 » 424mm > V slot 2 _
B-01 Screw bag
SKU Item Pcs Label

56-00617A  M5x25 socket head bolt .
Tarantula RS
Screws

56-00076A M5 whasher B-0

B-02

53-01698A Sheet Metal, for bed support 1 ®
51-01808B Soft Magnetic Pad 1
Heating bed (pre-assembled) 1

B-02 Screw bag B-02-1 Screw bag

SKU Item Pcs Label SKU Item Pcs Label
59-00005A Wheel 24mm 4 56-01700A  M4x40 bolt 4
53-00671A Aluminum column 2 Tevo

5x8mm,7mm length Tarantula RS 56-01699A  Springs 4x8mm, 4 Tarantula RS
53-01191A Eccentric nut 2 —— 25mm length ——
56-00075A M5 locknut 4 B-02 B-02-1
56-00277A CopperPad5x8x1 5 e 56-01758A  M5,Knurled thumb nuts 4 et
56-00586A M5x30 socket head bolt 4

B-03

59-01704B PC, for left X axis, Orange
59-01705B PC, for left X axis, black
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B-03 Screw bag
SKU Item Pcs Label

56-00855A M3x8 button head bolt
56-00060A M3x12 sockethead bolt,M/C
56-00066A M3 NUT

56-01064A M3 Washer

56-00675A T8 Leadscew nut,4teeth,8mm
56-00275A M5*20 socket head bolt
56-00076A M5 washer

56-00453A M3x30 button head bolt
53-00008A Timing wheel 5mm
56-00074A M5 nut

53-01191A Eccentric nut

56-00075A M5 locknut

56-00277A CopperPad 5x8x1
59-00005A Wheel 24mm

56-00643A M5*40 socket head bolt
53-00671A Aluminum Spacer

v

evo

Tarantula RS

Screws
B-03

BAWWNWNNHWNNE DB BRDS

B-04

Packing list ||

B-03-1 Screw bag
SKU Item Pcs Label
56-00292A M5x8 socket head bolt
56-00620A M5 T nut

2

2 V
14-00692A Endstop 3

2

6

ewo

Tarantula RS

Screws

55-00645B Y Endstop acrylic
B-03-1

56-01223A M2.8X6 bolt

59-01734B PC, for right X axis, Orange
59-01756B PC, for right X axis, black
59-01734B Tools

B-04 Screw bag

SKU Item Pcs Label
59-00005A Wheel 24mm 3
53-00671A Spacer 5x8mm,7mm length 4

A Tarantula RS
53-01191A  Eccentric nut 2

56-00075A M5 Locknut 3
56-00277A Copper Pad 5x8x1mm 2
56-00643A M5x40 socket head bolt 3
56-00292A M5x8 socket head bolt 2
2
2
1
1

Screws

56-00620A M5,T NUT

53-01269A Flange bearing F604zz
56-01271A M4x20 scket head bolt
53-01338A Spacer 4.2x7mm,6mm length
56-00274A M4 NUT 1

B-05

E3D (Pre-assembled) 1

B-07

07-00032A  Stepper motor, 40mm 2

B-07 Screw bag
SKU Item Pcs Label

53-00009A Coupler,5mm 8mm
59-01303B Motor fixed

56-00003A M4 T-nut

56-00302A M4x12 Socket head bolt
56-00950A M3x14 bolt

59-01076A O Ring

Tevo

Tarantula RS

Screws
B-07

NABBNON

B-04-1 Screw bag
SKU Item Pcs Label

59-00005A V-wheel 24mm 3
53-00671A Spacer 5x8mm,7mm length 2
53-01191A Eccentric nut
56-00075A M5 Locknut
56-00277A Copper Pad 5x8x1mm
56-00273A M5x25 sockethead bolt
56-00058A M3x8 socket head bolt
56-00855A M3x8 button head bolt

4
Tarantula RS

Screws
B-04-1

ANWF W

B-04-2 Screw bag
SKU Item Pcs Label

59-01787B Leadscrew fix part
53-00656A Flange bearing F688zz
56-00292A M5x8 socket head bolt
56-00620A M5 T nut

56-01213A M5x8 button head bolt

<.
Tarantula RS

Screws
B-04-2

AArBANON

B-06

Titan extruder (pre-assembled) 1

B-08

56-01703A Sheet Metal, for E30 1
56-01701A  Sheet Metal, 1
connect E3D with X axis
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Jll Assembly of the bottom frame A-01 Assembly of the bottom frame A-01 |}

Line up the extrusions as in picture and fasten those together using
M4x45 bolts and M5 spring washers. The parts needed for this 4-M4x20 Screw
assembly are found from A-0O1 bag and A-0O1 slot. i

F4-Rubber Foot

|
4-M4 T-nut

2-20x40-350mm Extrusion

— —p <

20x40-250mm Extrusion

4-M5 Spring Washer

—

— ST, |
—— SR |

4-M5x45 Screw

+ 250mm

4-M5x30 Screw

Give special attention for right orientation of the profiles and the ' 4-M5 Spring Washer
round slots. Those round slots are meant to countersunk bolts so '/
that bolt head will be hidden. 447

20x40-400mm
Extrusion
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]l Front panel assembly A-02 Y axis parts preparation A-03 [}

Prepare the front panel as shown and then slide it in frame, you can Prepare the Y axis idler and motor plate as shown in the following

find these items from slot A-O2 and A-02 bag. pictures. Leave the M5 bolts with T-nuts loose until the parts will be
installed to the frame. The parts for these steps are found from slot
A-03 and bag A-03.

o«
M4x25 Screw g\
2-M4x8 Screw

Aluminum column \Eyj
2-F6042zz Bearng =
3 4-M3x10 Screw Self-locking nuts \w

'/GTZ Timing Pulley
3-M4 T-nut \@ | 4-M3x6 Screw

P

40mm Motor
3-M4x8 Screw

A
20-20.1mm
Y

4-M4 T-nut

'\ 4-M4x8 Screw

11 12



Jll Bed carriage assembly B-02

Assemble the bed carriage as in picture. Tighten the two bolts which
have 6mm spacers gently but leave the two eccentric nut bolts
slightly loose so that eccentric nuts turn easily. The parts for this step
are found from B-02 slot and B-02 bag.

4-Pully wheel

2-Brass Shim

m -
2-7mm Aluminum column 4é] | * FZ-Eccentric Nut
I
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Finalizing the assembly A-01, A-02, A-03 and B-02 [}

Slide the bed in extrusion and install idler plate in the end of extrusion
as shown. Then slide carriage in frame and use the key to adjust the
eccentric nuts so that carriage is snug fit to rails and carriage moves
smoothly. In the end tighten the M5 nuts gently.

1

W

Eccentric nuts for carriage

Install the Y axis motor bracket and endstop in place and tighten the
bolts.



Jl Finalizing the assembly A-01, A-02, A-03 and B-02

Assemble the Endstop as in picture. Leave the M5 bolts with T-nuts
loose until the parts will be installed to the frame. The parts needed
for this assembly are found from B-03-1 bag

7

2-M2.8x6 Screw

M5x8 Screw

Endstop

|
I
I
I
|
[
v
I
%MSXT-nut
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Finalizing the assembly A-01, A-02, A-03 and B-02 ||}

Loop the GT2 belt around idler and motor pulley and connect both
ends to slots in heatbed carriage with zipties. Last step is to tighten
the belt which can be done by loosening slightly two M5 bolts hold-
ing idler plate in extrusion and sliding idler plate so that belt tightens
and then tightening the bolts again

GT2 Belt

16



]l Control box and front panel installation

Install the control box in the frame. Items required are found from
bag A-04. Use the M5x8 bolt and T-nut to attach
controller to middle extrusion as shown.

Loosen the screws on the Y profile before the power box is inserted,
otherwise it won't easy to put the control box into the alu frame.

6-M5x8 Screw

Slide the front panel in extrusions and tighten the M5 bolts in both
sides of the front panel.

Hotbed assembly [}

Install the hotbed and tighten the nuts just some turns as these are
later used to adjust the bed level. These parts can be found from

bag B-02-1.
4-M4x40 Screw

‘ V Hot bed

ﬁ
/4-Spring
4-Thumb nut
/

After this remove the cover from underside of heatbed cover and
install it on top of the heatbed surface. Try to do it so that there will
be no air bubbles left between the surfaces.

17
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]l X axis assembly left side B-03

Assemble the X axis as in picture. Parts for this step are found from
slot B-03 and bag B-03.

K 3-M5x40 Screw
N ,

,‘/. 4-7mm Alumimum column

\{ 3-Pully wheel
@

@\ 3-M5 Self-locking nuts
~

2-Eccentric Nut /\®

2-Brass Nut
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X axis assembly left side B-03 |}

Assemble the motor mount endpiece to the X axis extrusion as shown.
There is two bolt slots that match to the motor mount end- piece
threaded holes. The parts for these steps are found from slot B-01.

2-M5 nut
20x20-345mm Extrusion

Y 2-M5 Spring Washer

2-M5x20 Screw

2-M2.8x6 Screw —» Endstop

Then install the stepper motor pulley and limit switch to the end- piece.
Motor cable connector should face downwards.

/4-M3x8 Screw

~I~< GT2 Timing Pulley
S
-

The y motor’s timing aheel distance around 17.5mm.

~

40mm Motor

[}
17.5-17.7mm
y

20



] hotend assembly B-04-1

Assemble the hotend carriage as shown. Parts for this step are found
from slot B-08 and bag B-08.

3-M5x25 Screw
: E 2-7mm Aluminum column
\\\4 3-Pully wheel

= _

—

—

3-M5 Self-locking nuts

-y

\/@\

Eccentric Nut

Brass Shim

Install hotend carriage to extrusion and tighten the eccentric nut
again as explained in the heat bed assembly.

21

Right side assembly B-04 |}

Assemble the X axis Right side as in picture. Parts for this step are
found from slot B-04 and bag B-04,B-04-1.

3-M5x40 Screw

2-Eccentric Nut
\@/ /Z-Brass Shim

&

4-7mm Aluminum column \@
N

3-Pully wheel

6mm Aluminum column M4 nut

2-F604zz Bearing

Install the leadscrew nut as shown.

iiii\ 4-M3x12 Screw
|
|

4-M3 Spring Washer

Lead Screw Nut

;- V4'M3 nut

22



Jll Right side and hotend assembly B-04,B-08

Install the assembly to other side of extrusion as shown, you can leave

the M5x8 bolts slightly loose still as those will be tightened later in
assembly.

5x§§?réw——~

-
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2-20X40-424mm Extrusion

Upper frame assembly [}

Install the two Z axis extrusions to bottom frame using 4xM5x25 bolts
and 4xM5 spring washers. The parts are found from slot B-O1 and

4-M5 Spring Washer
K 4-M5x25 Screw

24



]l Z axis assembly BO7 Z axis assembly B-07,B-04-1 |}

Install the motor bracket and coupler with O-ring as shown and install You can now turn the leadscrew around midway in the leadscrew nut
then it to the Z axis extrusion as shown. The parts are found from bag B-07. and slide the X assembly on frame. Slide it down until the leadscrew
goes inside the coupler and then tighten the coupler holding screw.

2-T8 Lead Screw

-

. 2-M3x14 Screw €0 Rubber Ring /

| N - -
2-M4x12 Screw g,//vEli - 2-M4 T-nut
- -

40mm Motor

4-M4 T-nut \ 4-M4x12 Screw

25 26



]l Z axis assembly B-07

Assemble the Z axis top extrusion as in picture. Parts for this step are
found from slot B-01 and bag B-01.

4-M5x25 Screw ' l
!/ |
+/4-M5 Spring Washer T T

|
T

20x20-330mm Extrusion
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Z axis assembly BO7 |}

Assemble the leadscrew top bearing bracket as in picture. Parts for
this step are found from slot B-09 and bag B-04-2. After that, repeat
the instruction steps to install the other part.

g/ 2-M5x8 Semi-round head bolt

F688zz Bearing

v

@ yz-ms T-nut

28



]l Z axis assembly BO7 Z axis assembly BO7 |}

Pull the careiage out make sure it fix well.

2-M5x8 Screw

Tighten now thes

After this adjust again eccentric nuts so that Z axis moves smoothly
and then tighten again the M5 nuts. And as last step for X axis tighten Assemble the Titan Extruder as in picture. Parts for this step are found
the two M5x8bolts on right side. from slot B-06 and bag B-03.

3-M3x30 Screw

Titan extruder

40mm Motor
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]l Z axis assembly BO7 Z axis assembly BO7 |}
Assemble the Endstop as in picture. The parts needed for this assembly

Loose the X axis stepper bolts slightly so that stepper can move in
the slots. Install tightly the X axis belt and use zip ties to attach it to are found from B-03-1 bag

carriage and then you can use stepper to tighten the belt little more
and then tighten the screws.
<ﬁ 2-M2.8x6 Screw
I

M5x8 Screw
Endstop

@ M5xT-nut

Install the Z axis endstop as shown.

M5xT-nut

M5x8 Screw
Y

100mm

4-Zip Tie

l<
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] Hotend assembly B-05

Install the hotend holding plate and hotend assembly as shown in
pictures. Parts can be found from bag B-08 and slot B-O5, B-08.

33

Bed leveling |}

Adjust the wheels locate in 4 corners and make the filament come out
good as shown in picture “Proper nozzle height ”.

Mozzle too high

Filament
)

Nozzle too close

Proper nozzle height

Filament

34



]l Wiring and filament guide Hotend assembly B-05 ||}

The last step is to install the white teflon tube between extruder and Your Tarantula Pro V1 Assembly is done.
hotend and to connect the wires. Push gently the teflon tube in until it

stops. When connecting the wires check that connectors match and

amount of the pins is the same on both end . You can use zip ties to

fasten the hotend wires to teflon tube to increase rigidity.
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Jll Prepare Slicing Software Prepare Slicing Software |

This printer works with most slicing / printing software like Repe-tier Printer Settings
-Host, Cura, Simplify3D, etc. But we will go in details for Repe-tier- e .
. . Fri . aF an a -
Host and tell you how to set it up so that you can make your first from BuBESE m
our website at http://www.tevo.cn/software-download.php Connection | Printer | Extruder | Printer Shape | Seripts | Advance&l
After installation in done and you start the software, you should get , , ,
. . Connector: Serial Conmection -
the following screen:
Port: Auto -
) Repetier-Host V2.1.3 - B x Baud Rate: 250000 -
Fle View Config Printer Tools Help
" v = ® = Transfer Frotosel: o0 d 1.0t i
Connect | Load | Log Filament Travel Printer Settings Easy Made
3D View |Tgmpe,atm curve | Objeot Flacenent |51,cer | Prine Peevion | Mansal contro | s card |
@ @ Reset on Emergency 5.9 emer geney command and reconnect -
Feceive Cache Size: [127 |
% Communi catlon Timeoufl:i 40 | [=]
@. I:‘ Use PingPong Communication [Send only after ok)
ﬁ The printer zettings alwavs correspond to the selected printer at the top. Thew
< are stored with every OE or apply. To create a mew printer, just enter a new
Eﬂ printer name and press apply. The new printer starts with the last settings
@ zelectad
2
Yoda
Show in Log: @ Conmands @ Infos @ Warnings @ Errors O MK @ sutoSerall gy Clear Loz [§] Copy

FEPFTRTEEE] Using fast VBOs for rendering is possible
BEREIERLIELTY S1ic3r command:E:\Repetier-Host\Slic3r\slic3r-console.exe ——gui

Disconnected: default idle

| 114 | | Avolv | | Cancel

Now we have to set up our printer in the settings so that Repe- tier-

Host can connect to it and will know what size of the build area our Click on Printer Shape tab, change the following values:

printer use. Open the Printer Settings window (click Config Printer X Max - 240
Settings). Y Max - 240

Print Area Width - 235
First set port to whatever port your printer use (you have to connect Print Area Depth - 235
the printer to your computer before this step, or you can skip Port Print Area Height - 250

setting if you are going to print SD card only.) Set Baud Rate to
250000 and DO NOT touch any other settings in this tab.
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Jll Prepare Slicing Software Prepare Slicing Software |

Printer Settings Printer Settings
Frinter: Tarantula RE - 'ﬁ FPrinter: Tarantula RS - -ﬁ
Commection | Printer | Extruder Frinter Shape lScripts ] Advancedl Comnection | Frinter | Extruder ] Frinter Shape ] Seripts ] bdvanced ]
' . ' . el
Frinter Type: Claz=ic Frinter - Firmware Twpe: autodetect 3
BadX: o | Meie® o | ez P ] Traval Fasd Rate: [on/nin]
T Min ICI ¥ Max Bed Left: ICI Z—fxic Feed Rate: 000 [mmsmin]
Tiia [0 ] YoM [23 Bed Fromt: [0 | Manual Extrusion Speed: B | |20 | [nm/s]
Print hres Width:  [35 i Nenaal Retraction Specd (/]
Frint hrea Depth: 236 mm Default Extruder Temperature: 200 *C
Frint Area Height: _ mm Default Heated Bed Temperature: e
The min and max valnes define the poszible range of extruder coordinates.
These coordinates can be negative and cutside the print bed. EBed Check Extruder & Fed Temperature
left/fromt define the coordinates where the printhed itself starts. By
changing the min/max values you can even move the origin in the center of [ Eemove temperature requests from Log
the print bed, if supported by firmware.
" Check every 3 zeconds.
=] R
= .
P Fark Fosition: X [g | bR |D | Z min: ICl [mm]
Send ETA to printer display l:l Go to Park Position after Job/Ki1ll
Dizable Extruder after Job/Eill Dizahle Heated Bed after Joh/Kill
= E Disable Motors after Jobs/Ei1ll Printer has SD gard
Add to comp. Printing Time 8 [®]

Invert Direction in Contrels for X-hxis [ r-hxi= [Jz-txi= [JFlip ¥ and ¥

I B W

| OF | | Aooly | | Cancel | 1):4 | | honlw | | Cancel
Go to Printer tab, change the followin lues: . . . . .
Travel F”eed erte N 120?)0 wing vald On Repetier-Host main screen, click on Slicer tab on the right. Choose
Z-A xis Feed Rate - 15000 Slic3r from Slicer drop-down then click on Configuration button.
Manual Extrusion Speed - 2 / 20 On Slic3r window, click on File -> Load

Manual Retraction Speed - 30

Default Extruder Temperature - 200
Default Heated Bed Temperature - 55
Then click on OK to save the settings.
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]l Prepare Slicing Software

G Slicar

o X
File | Plater Object Sefiings View Window Help
@ Open STL/OBJ/AMF/3MF... cirl+0
(3 Open 25D TIN mesh.. Layer heights. Settings...
& Load Config.. Curl+l
7 e e Print settings: | b default o]
xport Config.. vl
) Load Config Bundle.. Filament: | default |
& Export Config Bundle... Printer: | (=) default o]
& Import Config from GCode-File... Export STL.. e
5 Quick Slice.. Cirl+U Support material
4 Quick Slice and Save As.. Cirl+Alt+U cenerat "
enerate suppor
Repeat Last Quick Slice Ctrl+Shife+U matorial: O
M Slice to SVG... Cul+G
& Repair STL file...
Preferences... Curl+,
Quit
Info
Object: v
Copies: Size:
Volume: Facets:
Materials: Marifold:

Browse to the SD card or the location you saved the config file.
(You can download the latest version of the config file from
http://www.tevo.cn/software-download.php) Select the ini file and

click on Open.
g slica

o
File Plater Object Settings View Window Help
& Select configuration to load: X
« v 4 > WA > Deskiop » config v| 8| | #m=config £
|Rv RS O @ e
A o - ~| %
7 OneDrive i &
1z Tarantula RS.ini =
= e el Fo-code..
| ELF:
[ Desktop.
B a
3=
bER
& Win 10 Pro x64 (C:)
- WEE)
o SR (\\192.168.11.3) (¥)
= home (\\192.168.11.3) (Z)
& F “hE e
STEE(N): [ Tarantula RS ini v [IN fles “ini v
$17F(0) B B o
Copies: ize:
Volume: Facets:
D review | Layers Materials: Manifold:
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Prepare Slicing Software |

Click on the Gear icon next to Print settings, Filament, Printer respectively.

G slicsr

File Plater Object Setfings View Window Help

Plater

3 Add.. Delete Delete All Arrange Scale. : split cut.. Layer heights Settings.

Print settings: | 4% Tarantula RS

Filament: Tarantula RS

Printer: | (&) Tarantula RS

Export STL..
Support material

Generate support
material

Info
Object;
Copies: Size:

Volume: Facets:

Materials: Manifold:

Export G-code..

O

Click on the Save icon on the next page, rename it to tevo-Tarantula

RS or any name of your choice.

§ shicar
File Dlater Object Settings View Window Help
Plater Print Settings X
Tarantula RS v|E® iLayer height
& Layers and perimeters O o
254 nfill X ;
First layer height mm or %
(8 Skirt and brim
AL Support material Use adaptive slicing: 0

© Speed Adaptive quality: s %
7 Muttiple extruders

Match horizontal surfaces:
#* Advanced

= Output options
1 Notes Vertical shells

& Shortauts Perimeters: = (minimurm)
Minimurm shell thickness: o Jum
m]

Spiral vase:

Horizontal shells

Solid layers: Tnp“ 1 \ = mmm] 3

Minimum shell thickness: o mm

Quality (slower siicing)

Extra perimeters if needed:
Avoid erossing perimeters:
Detect thin walls:

Detect bridging perimeters:

Advanced
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]l Prepare Slicing Software How to Slice 3D Object for SD Print |}

Click on Plater tab to go back to the main screen and do the same Click on Load, browse to location of the file to print, then choose Open.
for others. (Or you can drop and drop the STL file to Repetier-Host soft- ware.)

1o
§ sics - @ B3 S - Tae
# weaA =
File Plater Object Settings View Window Help oy Ve e
=
Plater Print Settings X s
Tarantula Pr vEHS e - o
Save preset X
Infill .
Skita | Tarantula RS ~ . o
4 sy be slicing:
= =
@ Speed ality: s %
' Multipreexeragers Miatch horizontal surfaces:
/' Advanced
= Output options
& Notes Vertical shells
& Shortauts Perimeters: [ ] minimum
Minimum shell thickness: o Jmm
Spiral vase: 0
Horizontal shells
Solid layers: Tup“ E Battom: ‘ 3 %
Minimum shell thickness: 0 mm
Quality (slower slicing)
P lick li b he righ
R Click on Slicer tab on the right.
Detect bridging perimeters:
Advanced 4 @) Repetier-Host V2.1.3 - Tevo-Logo.STL - o X
File Vi Help.

R 8 4

Connect Printer Settings Easy Mode

3D View |1m,,m,m Cures | Object Placenent |51,m | Print Ereview | Mmamal contral | 51 card |

COEEOEICAM

@ Tevorlors ! ]

DXDVB®ODHD

vs O K @ hutoSeroll  fy Clesr Loz [§) Copy

Disconnected: Tarantula RS - Idle
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Jll How to Slice 3D Object for SD Print How to Flash Firmware [}

Choose the config saved in previous step. Then click on Slice with
Slic3r.

@) Repetier-Host V2.1.3 - Tevo-Logo.STL - o X

B ¥ 2.

Printer Settings  Easy Mode

To install firmware on your printer, you’ll need to download the

1. Arduino IDE (http://www.arduino.cc)

Fle View Config Printer Tools Help

e ®

Log Filament Travel

B

Load

Firmware Source Code (You can get it from many sources,

Objast Flacement  SLicer | Print Fravies | Mamal Control | 50 card |

e.g. our Facebook Page Files section, our Customer Service,

[ Stice with Siics Software Download page on http://www.tevo.cn, or from
oo o ’ In this chapter, we’re going to use Marlin for demonstration.
e —— Configuration downloaded from our Facebook page, customer service,
b s TRl or software download page are pre-configured, you can use it without
A e e any modification. We’re not going to go into details how to configure
B e from scratch.
e
. —— To start the process, do the following steps:

Loz @ Comnands @ Infos @ Wanings @ Errors O ACK @ huto Soroll  y Clear Loz [) Copy 'I
B obiect is manifold. ~

Connect your printer to your computer with USB cable supplied.
—— : - 2. Double-click Flash.ino (or Marlin.ino) file to open it in Arduino
IDE.
3. Select Arduino/Genuino Mega or Mega 2560 from Tools ->
Board menu.
4. Select the serial (USB) port that your board is connected to in

After slicing, click on Save for SD Print to save the G-code file to
the SD card with file name of your choice. Then you can insert the
card to your printer and choose Print from SD to start printing.

Bl R Tools -> Serial Port menu.
SLE o) & 5. Click on Verify/Compile button at the top of the window to
o P FTyremy T ey P ey ey make sure there are no configuration errors. (If failed to compile,
C? } m: ""‘”‘F_‘ H mi“‘f:::‘ " please make sure you are using Arduino IDE 1.8.5 or up.)
g calors? B Exar 0. 6. After it compile successfully, click on Upload button.
® v N—— 7. Waiting for Arduino IDE to show Done uploading.
?ﬂ #i{;[ﬁnr;‘ ;?gsss

Filament needed 4997 mm
% Extruder 1 4997 mm
i
Eﬂ Visualization
® Epruidiciniort

O Show Single Layer

© Show Layer Range

2

Bl <s1ic3r> Done. Process took 0 minutes and 14.814 seconds
Bl <51ic3r> Filament Tequired: 4997.3mm (35.3cm3)

Loz @ Comends @ Infos @ Wanings @ Brrors O MK @ Auto Soroll

Clear Loz [§) Copy

Disconnected: Tarantula RS

Idle
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Jll Troubleshooting

Work Process

()
~—
Q
-
~

Print from SD

Se
3

-

Auto ho

3
5]

“Se
$

Heating bed

5
Q

e
J

Nozzle heating

e
&

Filament Feeding

«Se
J

Done

YES—) NO —)
Process —)
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Troubleshooting

>

>

File read == Garbled == Other file print ok ==p

Moving == Out of limit

>

>

4

Bed is heated == Temperature is read =P

>

Nozzle is heated == Temperature is read -

Wrong result

v

Filament out

v

E stepper
is working

>

=) Extruder
is working

>

=P Filament =P

is ok

-

>

Cause

SD Card

File name

Slicing

axis motor

End stops

Heat bed

-
N
-
-
-
-

Thermistor «=9

Heating tube ==

Thermistor «=9

Slicing/Belt =9

Couper

Other

Filament

-
-
-

Treatment

1. Clean the SD Card ==
2. Format SD Card
3. Change SD Card
Change file name =
into English/numbers

Move the model -
and slicing again

Relink the wires -
Relink the wires -
Relink the wires -

Relink the wires -

Relink the wires -

Relink the wires -

Slicing the file again ==

Print from SD -

1.Clean the filament ==
2.Change a filament

Troubleshooting [}

Feedback

_) Troubleshooting

Component
=) Result e=p damaged

=P Unknow reason

Relink the wires
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]l Tevo After-Sales

SERVICE INFORMATION

1. REPLACEMENT PARTS

1.1. Tevo products are covered under a Replacement Part Program
for a period of 12 months from the date of delivery.

1.2. Missing/Damaged/Defective Parts.
1.2.1. Within 7 days of the delivery date, Tevo will replace any
parts free of charge including shipping fees.

1.2.2. After 7 days of the delivery date, Tevo will replace any
parts free of charge BUT the customer will be responsible
for shipping fees.

1.3. Customer Damaged Parts.

1.3.1. The customer shall pay for the cost of the parts AND the
shipping fees.

2. CARRIER LOSS, MISSING, DAMAGED, AND DEFECTIVE PARTS

49

2.1. Claims for lost or damaged shipments must be reported to the
carrier within the carrier’s claim window, the customer needs
to inform Tevo within 7 days of the delivery date.

211. For any parts lost or damaged during shipping, the
customer shall take photos or video and submit them
when filling out a Service Ticket. If a claim number was
issued by the carrier, please include the claim number
when creating your Service Ticket (Report a Problem /
Carrier Lost Parts.)

2.1.2. Once the Carrier dispute is resolved, please provide Tevo
with all communications with the carrier. It is the custom-
er’s responsibility to keep Tevo up-to-date with ALL com-
munications with the carrier.

2.1.3. Tevo will work with the customer on replacing the parts in
the claim.

Tevo After-Sales [}

2.2. For Missing Parts, refer to section 1.2, the customer shall fill out
a Service Ticket (Report a Problem / Missing Parts.)

2.3. For Damaged Hardware Parts, refer to section 1.2, the custom-
er shall take photos or video and submit them when filling out
a Service Ticket (Report a Problem / Damaged Hardware
Parts.)

2.4. For Defective Electronic Parts, refer to section 1.2, the custom-
er shall take photos or video and submit them when filling out
a Service Ticket (Report a Problem / Defective Electronic
Parts.)

2.41. If the part is the LCD panel, Power Supply, or Mainboard,
the customer shall ship the part back to Tevo and Tevo will
send a new part.

2.5. For parts damaged by the customer, refer to section 1.3, the
customer shall submit a Service Ticket (Report a Problem /
Customer Damaged Parts.)

2. GENERAL SUPPORT

For information and support on building and operating your
TEVO Tarantula RS 3D printer, please visit :

TEVO Tarantula RS & Normal Prusa i3 Owners

https:/www.facebook.com/groups/TEVO.3dprinter.owners/
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